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Вступ 

 

Методичні вказівки призначені для освоєння методів експертної оцінки 

варіантів проектів. Розглянуто різні способи, що дозволяють приймати 

рішення на різних етапах проекту. Наведено методики безконфліктного 

ухвалення рішення при управлінні проектами. Для виконання даної роботи 

рекомендується використовувати програмні пакети Microsoft Excel, 

AutoCAD. 

Порядок виконання роботи: 

1. Ознайомитися з метою роботи і постановкою задачі. 

2. Вивчити технологію рішення задачі. 

3. Виконати роботу з використанням відповідного програмного 

забезпечення. 

4. Оформити звіт практичної роботи і захистити його. 

Звіт практичної роботи повинний містити: 

 титульний лист, оформлений відповідно до додатка 1; 

 мета роботи і постановка задачі; 

 опис технології виконання роботи; 

 висновки; 

 відповіді на контрольні запитання. 
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1. ЕКОЛОГІЧНА ЕКСПЕРТИЗА ПРОЕКТУ 

 

Практичне заняття 1 

ОЦІНКА ПРОЕКТУ ЕКСПЕРТНИМИ МЕТОДАМИ  

ПРИЙНЯТТЯ РІШЕННЯ 

 

Мета роботи 

Вивчити різні методи експертної оцінки варіантів рішень проекту, 

навчитися застосовувати дані методи  при груповій роботі. 

 

Постановка задачі 

Здійснити експертну оцінку: 

 проекту “Потреба у вивченні дисципліни “Управління проектами” за 

допомогою методів збалансованого голосування і вибору за багатьма 

критеріями; 

 проекту “Перспективність реалізації дипломного проекту кожного з 

учасників експертної групи” методом інтегральної оцінки. 

 

Теоретичні відомості 

При реалізації проекту на різних його етапах виникає проблема  

ухвалення рішення. Найбільш ефективні рішення в умовах невизначеності 

приймаються на основі групової роботи, тобто думки декількох експертів, що 

дозволяє при відсутності досить точних цифрових даних вибрати серед 

декількох рішень те, що є найкращим. Розглянуті нижче способи дозволяють 

врахувати позитивний внесок кожної думки і при цьому не дають приводу до 

дискусії (конфлікту). 

Спосіб «Збалансоване голосування» (табл. 1.1) дозволяє при 

відсутності досить точних цифрових даних вибрати серед декількох рішень 

(факторів) те, що здається найбільш важливим чи найкраще адаптованим до 

ситуації. Цей спосіб, зокрема, корисний в групі експертів, де всі члени мають 

різні думки. При збалансованому голосуванні кожен позитивно вносить свій 

внесок у вибір рішення, що не дає приводу до дискусії. 
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Суть методики полягає в тому, що кожен експерт має у своєму 

розпорядженні кількість балів, що відповідає кількості рішень. Потрібно 

розподілити бали між рішеннями  залежно від думки експерта. 

 

Таблиця 1.1 – Форма для збалансованого голосування 

 

 

 

Рішення  1 

 

Рішення 2 

 

… Рішення n 

 1 2 3 4 5 

Експерт      

Експерт      

...     

Експерт  m     

Разом     

 

Максимальний бал присвоюється найкращому рішенню і так далі. 

Перевага методики в тому, що кожен учасник бере участь у голосуванні і 

виборі рішень, на противагу голосуванню «ні», що породжує незадоволеність 

учасників, вибір яких не підтримується. 

Потім підраховується сума балів по кожному рішенню. Цей дозволяє 

кількісно оцінити рішення (фактори), визначити його пріоритет, тобто 

ранжирувати усі рішення. 

Дану методику доцільно застосовувати на середніх фазах життєвого 

циклу проекту, тобто на стадії проектування і реалізації. У цьому випадку 

мається більше інформації про критерії. 

Спосіб «Вибір за багатьма критеріями» вирішує ті ж задачі, що й у 

випадку збалансованого голосування, але вибір за багатьма критеріями 

дозволяє, крім того, виявити ефективність рішення, виходячи з важливості 

критеріїв, що визначаються групою експертів (таблиця 1.2). 

Група проводить збалансоване голосування, щоб вибрати деякі з усіх 

запропонованих критеріїв для аналізу рішень. Залежно від отриманих сум 

критерії ранжируються. Першим вибирається критерій з максимальною сумою 

і записується в стовпець 1 таблиці 1.2. Потім проводиться збалансоване 
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голосування по кожному з рішень, але з урахуванням обраних критеріїв. 

Отримана частинна сума помножується на коефіцієнт вагомості 

відповідного критерію. 

В подальшому обчислюються підсумкові суми по кожному рішенню, 

що дозволяє визначити пріоритетність того чи іншого рішення. 

Розглянутий спосіб можна застосовувати на стадії завершення проекту, 

а також для оцінки досяжності поставлених цілей. 

Запропоновані способи дозволяють втягнути в процес ухвалення 

рішення широке коло експертів. При цьому враховується думка кожного з 

них, і воно не протиставиться іншим думкам. 

 

Таблиця 1.2 – Форма для способу «Вибір за багатьма критеріями» 

 

Критерії Експерти Рішення  1 Рішення  2 … Рішення n 

Критерій  1 

Експерт 1     

Експерт 2     

…     

Експерт n     

3       

Критерій  2 

Експерт 1     

Експерт 2     

…     

Експерт  n     

2       

Критерій 3 

Експерт 1     

Експерт 2     

…     

Експерт n     

1       

Разом 

 

     

 

Це підвищує якість прийнятого рішення, особливо при відсутності 
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достатньої кількості точних цифрових даних. 

Розглянемо задачу аналізу здійснюваності рішення на основі якісних 

показників. З цією метою можна використовувати нескладну експертну 

систему «Інтегральна оцінка варіантів рішень», представлену нижче. 

Суть  даної методики полягає у визначенні факторів, що можуть у 

значній мірі вплинути на успішність виконання рішення. Потім фактори 

розташовуються в порядку убування пріоритетності. Для цього визначається, 

який з факторів найбільшою мірою вплине на хід реалізації проекту. Далі 

визначається найбільш істотний фактор із тих, що залишилися і т. д. 

Послідовність, що вийшла, заноситься в таблицю 1.3. 

Після розміщення факторів здійснюється оцінка вагомості (рангу) 

кожного з перерахованих факторів. Сума рангів усіх факторів повинна 

дорівнювати одиниці. Тобто сума стовпця 3 таблиці 1.3 повинна дорівнювати 

одиниці. 

 

Таблиця 1.3 – Форма для інтегральної оцінки варіантів рішень 

 

№ 

з/п 

Характеристика 

фактору 

Показник 

вагомості 

Номер рішення 
Інтегральна оцінка 

рішення 

1 2 3 4 … 1 2 3 4 
.

 … 

1 2 3 4 5 6 7 8 9 10 11 12 13 
1 

2 

3 

… 

 

і т.д. 

            

Разом  1,0           

 

Далі всі рішення необхідно оцінити за кожним з факторів (критеріїв) 

оцінки. З цією метою кожному фактору виставляються бали (стовпці 48).  

Максимальний бал кожного з факторів дорівнює, наприклад, 100, 
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мінімальний  0. Наприклад, якщо експерти визнають, що попит на 

продукцію проекту буде необмеженим, то значення фактора «попит на 

продукцію (послуги)» проекту для даного варіанта проекту (рішення) 

дорівнює 100 балам. 

Після перемноження коефіцієнта вагомості кожного фактора (стовпець 

3) і значення оцінки по кожному з рішень (стовпці 48) одержуємо 

інтегральну експертну оцінку, що записується в стовпці 913. Інтегральна 

експертна оцінка пріоритетності варіантів проекту (рішення) визначається як 

сума по стовпцях 913. 

Дана методика може застосовуватися як для попереднього добору 

найбільш перспективних варіантів рішень, так і для попереднього визначення 

здійснюваності рішень. У першому випадку для подальшого розгляду 

залишаються альтернативи, що одержали найвищі результати, у другому  

отримана інтегральна експертна оцінка проекту порівнюється з визначеним 

заздалегідь "обмеженням знизу". Якщо отримане експертним шляхом 

значення вище встановленої межі, рішення визнається здійсненним.  

Запропонована вище експертна система може застосовуватися на 

початкових фазах життєвого циклу проекту, зокрема на стадії розробки 

концепції. Це обумовлено тим, що на даному етапі використовується 

інформація з великим ступенем невизначеності.  

Недоліком розглянутої методики є те, що в ній не відбивається, як 

враховується думка кожного експерта. Наприклад, на першому кроці при 

виборі факторів, що можуть значно вплинути на успішність виконання 

рішення, чи на другому, коли ці фактори ранжируються і т.д. Цього недоліку 

позбавлений метод збалансованого голосування і метод вибору за багатьма 

критеріями. 

 

Прядок виконання роботи 

1. Виконати оцінку рішень щодо проекту “Потреба у вивченні 

дисципліни “Управління проектами” за допомогою методів збалансованого 

голосування і багатокритеріального вибору. 

Вивчити наведені вище методи експертної оцінки варіантів рішень 
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проекту.  

Запустити програму Excel. Виконання роботи варто почати з вибору 

варіантів рішень за проектом “Потреба у вивченні дисципліни “Управління 

проектами”. Такими варіантами можуть бути рішення з приводу термінів 

вивчення дисципліни, наприклад: на старших курсах, на курсах підвищення 

кваліфікації і т.д., чи будь-які інші обрані вами рішення. Побудуйте таблицю 

за формою 1. Кожному варіанту рішення повинен відповідати свій стовпець.  

Кількість рядків таблиці повинна відповідати кількості учасників експертної 

групи, прізвища яких вносяться в перший стовпець.  

Кожен учасник експертної групи має у своєму розпорядженні кількість 

балів, що відповідають числу варіантів рішень. За суб’єктивною оцінкою 

кожного з експертів рішенням привласнюються визначені бали, що 

заносяться в побудовану таблицю. Максимальний бал привласнюється 

найкращому рішенню. При цьому один експерт не може давати однакові 

бали різним рішенням.  

Після того як всі експерти проставили свої оцінки, рахується сума балів 

по кожному рішенню з використанням функції СУММ програми Excel.  

Для здійснення оцінки рішень проекту методом вибору за багатьма 

критеріями побудуйте таблицю за формою 2. При цьому учасники експертної 

групи повинні запропонувати критерії, за якими буде здійснюватись оцінка 

рішень. Далі група проводить збалансоване голосування з метою вибору 

найбільш значимих із запропонованих критеріїв для аналізу рішень. Критерії 

ранжируються залежно від отриманих сум, тобто їм привласнюються 

коефіцієнти вагомості 1, 2, 3, ..., n. Найбільш значимому критерію 

привласнюється  найбільший коефіцієнт, найменш значимому – найменший 

(одиниця). 

По кожному рішенню обчислюється сума балів і збільшується на 

коефіцієнт вагомості відповідного критерію. Підраховується сума отриманих 

результатів за всіма критеріями для кожного рішення. Всі обчислення 

проводяться за допомогою відповідних функцій програми Excel.  

За отриманими результатами слід зробити висновок, яке з рішень є 

оптимальним. Оптимальному рішенню відповідає максимальна кількість 
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балів. 

2. Виконати оцінку рішень щодо проекту «Перспективність реалізації 

дипломного проекту кожного з учасників експертної групи» за допомогою 

методу інтегральної оцінки. 

Вивчить наведені вище методи експертної оцінки варіантів рішень 

проекту.  

Запустіть програму Excel. Рішеннями по даному проекту є теми 

дипломних робіт (проектів) учасників експертної групи. Виконання роботи 

почніть з вибору критеріїв (факторів), за якими буде оцінюватися кожне з 

рішень.  

Побудуйте таблицю за формою 3. Занесіть в таблицю наявні рішення і 

критерії, при цьому критерії слід розташувати в порядку убування 

пріоритетності. Після розміщення критеріїв проводиться оцінка вагомості 

(рангу) кожного з них. Сума рангів повинна дорівнювати одиниці. 

Оцініть усі рішення по кожному з критеріїв і проставте бали відповідно 

до стовпця таблиці. Максимальний бал по кожному з критеріїв можна 

прийняти рівним 100, мінімальний – 0. Чим ширша шкала оцінки, тим більш 

точними будуть отримані результати.  

Для одержання інтегральної експертної оцінки слід помножити 

значення оцінки по кожному з рішень на коефіцієнт вагомості кожного 

критерію. Інтегральна оцінка пріоритетності рішень проекту визначається як 

сума інтегральних оцінок по кожному з критеріїв. Всі обчислення 

здійснюються за допомогою відповідних функцій програми Excel.  

Оптимальним буде те рішення, інтегральна оцінка пріоритетності якого 

максимальна. 

 

 

 

Контрольні запитання 

1. У чому суть методу збалансованого голосування? 

2. Які можливості й особливості застосування методу збалансованого 

голосування? 
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3. Які задачі дозволяє вирішувати метод багатокритеріального вибору? 

4. У чому полягає перевага методу багатокритеріального вибору перед 

методом збалансованого голосування? 

5. У чому суть методу інтегральної оцінки варіантів рішень? 

6. Які недоліки методу інтегральної оцінки варіантів рішень? 

 

 

 

2. КОМП’ЮТЕРНА ТЕХНОЛОГІЯ ЕКОЛОГІЧНОЇ 

ЕКСПЕРТИЗИ ПРОЕКТУ  

 

Для автоматизованого одержання кількісних і графічних оцінок 

інсоляції приміщень призначена система геометричного моделювання (СГМ) 

на ПЕОМ. СГМ реалізована в системі автоматизації проектування AutoCAD і 

працює під управлінням операційного середовища Windows. Для оцінки 

приміщення по інсоляції в системі мається можливість розрахунку часу 

інсоляції приміщення в зазначених точках побудови поверхні розподілу часу 

інсоляції, визначення зон комфорту всередині приміщення. 

Запуск системи СГМ здійснюється подвійним щигликом лівої кнопки 

миші на ярлику, розташованому на робочому столі Windows. Після входу в 

систему необхідно створити новий рисунок, увійшовши в пункт меню 

File=>New. Як прототип нового рисунка необхідно вибрати файл Astr.dwt, 

розташований у каталозі C:\SGM\. Потім його потрібно зберегти за 

допомогою пункту меню File=>Save на твердому магнітному диску 

(вінчестері). Ім’я файлу рисунка необхідно задавати в такому вигляді: 

XXXYYZZZ , 

де XXX  номер групи (наприклад, М51); YY  номер студента за списком 

(студенти з номерами за списком до 10 пишуть свої номери, додаючи ліворуч 

0, наприклад, 01, 02 і т.д.); ZZZ  будь-які літерно-цифрові символи (можуть 

бути відсутніми). Ім’я файлу варто набирати без пробілів, рисок, ком і т.п. 
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Практичне заняття 2 

ВИЗНАЧЕННЯ ЧАСУ ІНСОЛЯЦІЇ ЗАДАНИХ РОЗРАХУНКОВИХ 

ТОЧОК ПРИМІЩЕННЯ 

 

Мета роботи 

Вивчити графоаналітичний метод оцінки значень часу інсоляції в 

заданих розрахункових точках приміщення від одного і декількох вікон і 

провести розрахунки за допомогою ПЕОМ при заданих вихідних даних. 

 

Постановка задачі 

Відомі геометричні параметри (ширина, глибина і висота) приміщення. 

Задано кількість вікон, їхні геометричні параметри (розміри і положення). 

Задано місце розташування розрахункових точок усередині приміщення. 

Необхідно визначити значення часу інсоляції в розрахункових точках 

від кожного вікна і всіх одночасно. 

 

Прядок виконання роботи 

Запустіть систему СГМ і почніть новий рисунок, задавши йому ім’я 

відповідно до встановлених правил. 

Створіть каркасну модель приміщення. Для цього виберіть пункт меню 

СГМ=>Світлотехніка=>Приміщення. Відкриється діалогове вікно 

Параметри приміщення. Введіть параметри приміщення, які описані в 

таблиці 2.1. 

 

Таблиця 2.1  Параметри приміщення 

 

Найменування Опис значення, що вводиться 

1 2 

Ім’я Найменування приміщення 

Текст 
Додаткові характеристики приміщення. Це поле можна не 

заповнювати 
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Продовження табл. 2.1 

1 2 

Ширина 

Ширина приміщення в мм, наприклад, 3900. Ширина 

приміщення відкладається по осі X поточної системи 

координат 

Довжина 

Довжина приміщення в мм, наприклад, 6000. Довжина 

приміщення відкладається по осі Y поточної системи 

координат 

Висота 
Висота приміщення в мм, наприклад, 3000. Висота 

відкладається по осі Z поточної системи координат 

Орієнтація 

Орієнтація задається в градусах і показує орієнтацію 

приміщення по сторонах світу. 0 у цьому полі означає, що 

стіни, що визначають ширину приміщення (задана в поле 

Ширина), мають східний напрямок 

Точка вставки Визначає координати X і Y кутової точки приміщення 

 

Для завершення введення параметрів приміщення натисніть кнопку 

ОК. У робочій зоні екрана буде зображена каркасна модель приміщення в 

південно-східному ізометричному вигляді.  

Завдання параметрів вікна здійснюється вибором пункту меню 

СГМ=>Світлотехніка=>Вікно. Відкриється діалогове вікно Параметри 

вікна. У полях задайте необхідні параметри відповідно до додатка 2. 

Коли всі параметри вікна введені, натисніть на кнопку ОК. Якщо 

параметри задані правильно, на моделі приміщення з’явиться зображення 

вікна. Параметри другого вікна вводяться аналогічно. Вікна завжди 

розташовуються на західній стіні приміщення при нульовій орієнтації 

будинку. 

Положення розрахункових точок задається за допомогою пункту меню 

СГМ=>Світлотехніка=>Точка. У діалоговому вікні Розрахункова точка 

необхідно спочатку задати приміщення. Для цього натисніть на кнопку 

Приміщення і за допомогою графічного курсору вкажіть на одне з ребер 

приміщення. 

Для завершення операції клацніть правою кнопкою миші або  натисніть 

на клавішу Enter. Введіть координати розрахункової точки у відповідні поля, 

відповідно до Додатку 3. Коли координати введені, натисніть на кнопку 
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Розмістити, щоб розрахункова точка з’явилася усередині приміщення. 

Введення повторіть для кожної розрахункової точки. Для виходу з 

діалогового вікна клацніть по кнопці ОК. У результаті всередині приміщення 

з’явиться зображення усіх введених розрахункових точок (рис. 2.1). Якщо 

цього не відбулося, то або ви неправильно ввели координати точок, або 

невірно обраний формат представлення точок на екрані. У першому випадку 

необхідно повторити введення точок, а в другому  вибрати пункт меню 

Format=>Point Style і в діалоговому вікні стилю точок вибрати зображення 

точки у вигляді перекресленого кола розмір точки 5% від розміру екрана. 

 

Рисунок 2.1 – Зображення побудованого приміщення з вікнами і 

розрахунковими точками 

Обчислення часу інсоляції розрахункових точок приміщення через 

одне з вікон здійснюється за допомогою пункту меню 

СГМ=>Світлотехніка=>Інсоляція точок. У діалоговому вікні Інсоляція 

точок необхідно задати дату 22.03 – день весняного рівнодення, географічну 

широту міста Харкова - 50° півн.ш. Для вказівки приміщення натисніть на 

кнопку Приміщення і за допомогою графічного курсору вкажіть на одне з 

ребер приміщення. Для завершення операції клацніть правою кнопкою миші 

або натисніть на клавішу Enter. Аналогічно за допомогою кнопки Вікно 

здійснюється вибір вікна, через яке інсолюється приміщення. Для вказівки 

розрахункових точок натисніть на кнопку Розрахункові точки. Система 

перейде в режим вибору точок, а у вікні команд з’явиться запрошення 
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Виберіть точки. Необхідно покажчиком миші по черзі вибрати всі 

розрахункові точки. Для завершення вибору натисніть на праву кнопку миші. 

Після цього у вікні команд буде відображена інформація про кожну 

розрахункову точку і час інсоляції в цій точці. Щоб переглянути цю 

інформацію, потрібно залишити діалогове вікно, натиснувши на кнопку ОК, і 

розгорнути вікно команд на весь екран, натиснувши на клавішу F2. Тим же 

способом потрібно зробити розрахунок часу інсоляції в кожній 

розрахунковій точці через друге вікно і через два вікна одночасно. Отримані 

результати внесіть у табл. 2.2. 

 

Таблиця 2.2  Час інсоляції розрахункових точок 

 

Номер 

точки 

Координати 

розрахункової 

точки 

Інсоляція через 

перше вікно 

Інсоляція 

через друге 

вікно 

Інсоляція 

X Y Z 

1       

2       

…       

10       

 

Для обчислення часу інсоляції в розрахункових точках при іншій 

орієнтації приміщення необхідно повернути приміщення за допомогою 

команди редагування Rotate і повторити усі вказані вище дії. Потрібно 

одержати значення часу інсоляції в розрахункових точках при східній, 

південно-східній, південній, південно-західній і західній орієнтації вікон 

приміщення. Для кожної орієнтації приміщення потрібно заповнити табл. 2.2. 

По завершенні лабораторної роботи збережіть отримане креслення для 

використання його в наступних роботах. 

Вихідні дані для приміщень і вікон наведені в додатку 2. Координати 

розрахункових точок подані в додатку 3. 
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Контрольні запитання 

1. Назвіть умови  інсоляції розрахункової точки. 

2. Розповісти про порядок завдання параметрів приміщення, вікон, 

розрахункових точок. 

3. Як обчислити час інсоляції в розрахунковій точці? 

4. Як змінити орієнтацію приміщення? 

 

 

Практичне заняття 3 

ПОБУДОВА ПОВЕРХНІ РОЗПОДІЛУ ЧАСУ ІНСОЛЯЦІЇ В 

ПРИМІЩЕННІ 

 

Мета роботи 

Використовуючи графоаналітичний метод, побудувати поверхні 

розподілу часу інсоляції приміщення і знайти максимальне значення часу 

інсоляції від одного і декількох вікон. 

 

Постановка задачі 

Відомі геометричні параметри приміщення і його вікон. Задано крок 

(дискретність) сітки розрахункових точок. 

Необхідно одержати графічну оцінку інсоляції приміщення через 

кожне вікно і через усі вікна одночасно, побудувавши поверхні розподілу 

часу інсоляції. На цих поверхнях знайти максимальне значення часу 

інсоляції. 

 

Прядок виконання робіт 

Для графічної оцінки інсоляції приміщення на його умовній робочій 

поверхні (площини  підлоги чи паралельній їй на деякій висоті) вноситься 

сітка з заданим кроком. У вузлах цієї сітки обчислюється час інсоляції. 

Отримані значення відкладаються по аплікаті (третій координаті) при 

обраному масштабі. Після обчислення часу інсоляції у всіх вузлах сітки 

одержимо множену  тривимірних точок, через які будується тривимірна 
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поверхня розподілу інсоляції приміщення через обране вікно. На поверхні 

відшукується точка з максимальною інсоляцією. Таким способом 

здійснюється оцінка інсоляції приміщення через кожне вікно і через усі вікна 

одночасно. 

Запустіть систему СГМ. Якщо на диску існує файл креслення з 

попередньої роботи, відкрийте його за допомогою пункту меню File=>Оpen. 

Інакше почніть новий рисунок і визначить в ньому параметри приміщення і 

вікон так само, як у лабораторній роботі 2. 

Побудуйте поверхню розподілу інсоляції приміщення через одне вікно, 

Для цього виберіть пункт меню СГМ=>Світлотехніка=>Поверхня 

інсоляції. В діалоговому вікні, що відкрилося, Поверхня інсоляції 

необхідно задати дату 22.03  день весняного рівнодення, географічну 

широту міста Харкова  50° півн. ш. У полі Крок сітки вкажіть крок сітки в 

мм для розрахунку інсоляції. Задовільні результати дає сітка з числом точок 

по кожній осі  від 20 до 30. Виходячи з цього, задайте крок сітки. 

Наприклад, при ширині приміщення 7 метрів, щоб одержати 20 точок по осі 

X, потрібно задати крок по X рівним 350 мм. Для зазначення приміщення 

натисніть на кнопку Приміщення і за допомогою графічного курсору 

вкажіть на одне з ребер приміщення. Для завершення операції клацніть 

правою кнопкою миші або натисніть на клавішу Enter. Аналогічно за 

допомогою кнопки Вікно здійснюється вибір вікна, через яке інсолюється 

приміщення. Потім клацніть на кнопці Побудувати поверхню і для закриття 

вікна  на кнопці ОК. У результаті буде побудована поверхня розподілу 

інсоляції приміщення (рис. 3.1). 

 Щоб на побудованій поверхні знайти точку з максимальною 

інсоляцією, необхідно включити режим об’єктної прив’язки Intersection або 

Endpoint. Для цього можна використовувати пункт меню Tools=>Object 

Snap Selling. Щоб знайти на поверхні точки з максимальним значенням по 

координаті X використовуйте команду Tools =>Inquiry =>ID Point. Запишіть 

її координати. Варто мати на увазі, що час інсоляції точки в хвилинах можна 

одержати, розділивши значення її координати Z на 10. Це пов’язано з тим, що 

при побудові поверхні система СГМ відкладає по осі аплікат час інсоляції в 
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масштабі 1:10. 

 

Рисунок 3.1  Побудована поверхня розподілу інсоляції приміщення через 

перше вікно 

Видаліть побудовану поверхню. Потім повторіть дії для побудови 

поверхні інсоляції приміщення через друге вікно (рис. 3.2) і через два вікна 

одночасно (рис. 3.3). Визначить для кожного варіанта точку з максимальною 

інсоляцією. 

 

Рисунок 3.2  Побудована поверхня розподілу інсоляції приміщення через 

друге вікно 
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Рисунок 3.3 – Побудована поверхня розподілу інсоляції приміщення через обидва 

вікна 

Для обчислення максимального часу інсоляції при іншій орієнтації 

приміщення необхідно повернути приміщення за допомогою команди 

редагування Rotate і повторити усі вказані вище дії. Потрібно одержати 

значення часу інсоляції розрахункових точок при східній, південно-східній, 

південній, південно-західній і західній орієнтації вікон приміщення. Для 

кожної орієнтації приміщення потрібно заповнити табл. 3.1. 

 

Таблиця 3.1  Максимальний час інсоляції приміщення 

 

Орієнтація 

Інсоляція від 

першого вікна 

Інсоляція від 

іншого вікна 

Інсоляція від  

двох вікон 

X Y Z Imax X Y Z Imax X Y Z Imax 

С             

Пд-С             

Пд             

Пд-3             

З             

 

По завершенні лабораторної роботи збережіть отримане креслення для 



20 

використання його в наступних роботах і залишіть систему СГМ. 

 

 

 

Контрольні запитання 

1. Опишіть графоаналітичний метод оцінки інсоляції приміщення. 

2. Як з використанням системи СГМ побудувати поверхню розподілу 

інсоляції приміщення? 

3. Викладіть технологію визначення точки усередині приміщення з 

максимальним часом інсоляції. 

4. При якій орієнтації приміщення отримана точка з максимальним 

часом інсоляції? 

 

 

Практичне заняття 4 

ВИЗНАЧЕННЯ ЗОН КОМФОРТУ (ДИСКОМФОРТУ) ПО ІНСОЛЯЦІЇ 

ТА ОБЧИСЛЕННЯ ЇХНІХ ХАРАКТЕРИСТИК 

 

Мета роботи 

Використовуючи графоаналітичний метод оцінки інсоляції приміщення 

і побудовану з його допомогою поверхню розподілу часу інсоляції через усі 

вікна одночасно, визначити зону комфорту по інсоляції і знайти її 

характеристики. 

 

Постановка задачі 

Є поверхня розподілу значень часу інсоляції приміщення через усі його 

вікна. Відомий максимальний час інсоляції Imax. Задано припустиме значення 

часу інсоляції Ід, що задовольняє умову Ід < Imax. Необхідно побудувати зону 

комфорту по інсоляції, обчислити її площу, а також коефіцієнт комфорту 

приміщення по інсоляції. 
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Прядок виконання робіт 

Для перебування демаркаційної кривої (границями між зонами 

комфорту і дискомфорту) на висоті, що відповідає припустимому значенню 

Ід, будується площина, рівнобіжна робочій поверхні. Знаходиться 

перетинання даної площини з побудованою поверхнею розподілу інсоляції 

приміщення. Отримана крива проектується на робочу поверхню (площина 

підлоги). У результаті одержимо границю зон комфорту і дискомфорту по 

інсоляції. Ці зони можуть бути в загальному випадку незв’язними, тобто 

являти собою кілька непересічних областей. 

Для отриманої зони комфорту по інсоляції обчислюється її площа, а 

потім коефіцієнт комфорту інсоляції. 

Запустіть систему СГМ. Якщо на диску існує файл креслення з 

попередньої роботи, відкрийте нею за допомогою пункту меню FiIe=>Open. 

Інакше почніть новий рисунок, визначить в ньому параметри приміщення і 

вікон так само, як у лабораторній роботі 2, і побудуйте область розподілу 

інсоляції приміщення через два вікна, як у лабораторній роботі 3. 

Зона комфорту по інсоляції будується за допомогою діалогового вікна, 

що викликається за командою СГМ=>Світлотехніка=>Зона комфорту по 

інсоляції. У діалоговому вікні, що відкрилося, за допомогою кнопки 

Приміщення необхідно вказати приміщення, а в поле Рівень інсоляції  

ввести припустимий час інсоляції 150 хв. Побудова зони комфорту 

здійснюється після натискання на кнопку Побудувати зону комфорту. Щоб 

побачити результат побудови, потрібно закрити діалогове вікно, клацнувши 

по кнопці ОК. 

Щоб одержати кількісні характеристики отриманої зони комфорту 

потрібно за допомогою команди PLINE обвести границю зони (рис. 4.1), і 

командою Tools=>Inquiry:=>Area з опцією Entity зробити розрахунок площі 

зони комфорту. Для того щоб одержати значення зони в м2, необхідно 

розділити отримане число на 106. Запишіть отриманий результат. 
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Рисунок 4.1 – Побудована зона комфорту по інсоляції через два вікна 

Обчисліть коефіцієнт комфорту із заданим рівнем інсоляції. Для цього 

необхідно розділити отриману площу комфорту на загальну площу 

приміщення. 

Розрахунок площі зони комфорту і коефіцієнта комфорту необхідно 

зробити для різних кутів орієнтації приміщення. Отримані результати 

занесіть у таблицю 4.1. 

 

Таблиця 4.1  Показники комфорту по інсоляції 

 

Орієнтація Площа зони комфорту Коефіцієнт комфорту 

С   

Пд-С   

Пд   

Пд-З   

З   

 

Контрольні запитання 

1. Опишіть технологію побудови зони комфорту по інсоляції 

приміщення. 

2. Як засобами системи СГМ побудувати зону комфорту з 



23 

припустимим рівнем інсоляції 2,5 год? 

3. При якій орієнтації приміщення коефіцієнт комфорту по інсоляції 

максимальний? 

 

 

Практичне заняття 5 

ЕКОЛОГІЧНА ЕКСПЕРТИЗА ПРОЕКТУ З ВИКОРИСТАННЯМ 

КОЕФІЦІЄНТУ ПРИРОДНЬОГО ОСВІТЛЕННЯ 

 

Мета роботи 

Вивчити графоаналітичний метод оцінки значень коефіцієнта 

природного освітлення (КПО) в заданих розрахункових точках приміщення,  

від одного і декількох вікон і провести розрахунки за допомогою ПЭВМ при 

заданих вихідних даних, 

 

Постановка задачі 

Відомі геометричні (ширина, глибина і висота) і світлотехнічні 

(коефіцієнти відображення світла від стелі, стін і підлоги), параметри 

приміщення. Задано кількість вікон, їх геометричні (розміри і положення) і 

світлотехнічні (коефіцієнти світлопропускання), параметри. Задано місце 

розташування розрахункових точок усередині приміщення. 

Необхідно визначити значення КПО в розрахункових точках від 

кожного вікна і всіх одночасно. 

 

Прядок виконання робіт 

Запустіть систему СГМ і почніть новий рисунок, задавши йому ім’я 

відповідно до правил. 

Створіть каркасну модель приміщення. Для цього виберіть пункт меню 

СГМ=>Світлотехніка=>Приміщення. Відкриється діалогове вікно 

Параметри приміщення. У полях уведення даного вікна введіть параметри 

приміщення, описані в табл. 5.1. 
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Таблиця 5.1 – Параметри приміщення 

 

Найменування Опис значення, що вводиться 

Ім’я Найменування приміщення, наприклад, кухня 

Текст 
Додаткові характеристики приміщення. Це поле можна 

не заповнювати 

Ширина 

Ширина приміщення в мм, наприклад, 3900. Ширина 

приміщення відкладається по осі X поточної системи 

координат 

Найменування Опис значення, що вводиться 

Довжина 

Довжина приміщення в мм, наприклад, 6000. Довжина 

приміщення відкладається по осі Y поточної системи 

координат 

Висота 
Висота приміщення в мм, наприклад, 3000. Висота 

відкладається по осі Z поточної системи координат 

Орієнтація 

Орієнтація задається в градусах і показує орієнтацію 

приміщення по сторонах світу. 0 у цьому полі означає, 

що стіни, що визначають ширину приміщення (задана в 

поле Ширина), мають східний напрямок 

Точка вставки Визначає координати X і Y кутової точки приміщення 

 

Завдання параметрів вікна здійснюється вибором пункту меню 

СГМ=>Світлотехніка=>Вікно. Відкриється діалогове вікно Параметри 

вікна. У полях введення задайте необхідні параметри, описані в табл. 5.2. 
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Таблиця 5.2  Параметри вікна 

 

Найменування Опис значення, що вводиться 

Ширина ширина вікна в мм, наприклад, 1800 

Довжина висота вікна в мм, наприклад, 1200 

Висота 

підвіконня 
висота нижньої грані вікна над рівнем підлоги 

Ширина 

простінка 

ширина лівого простінка, тобто відстань від кута 

приміщення  до вікна. 

Приміщення 

після натискання на дану кнопку в графічній зоні екрана 

необхідно курсором вказати одне з ребер приміщення. Для 

завершення вибору клацніть правою кнопкою миші чи 

натисніть клавішу Enter 

 

Коли всі параметри вікна введені, натисніть на кнопку ОК. Якщо 

параметри задані правильно, на моделі приміщення з’явиться зображення 

вікна. Параметри другого вікна вводяться аналогічно. Вікна завжди 

розташовуються на західній стіні приміщення при нульовій орієнтації 

будинку. 

Положення розрахункових точок задається за допомогою пункту меню 

СГМ=>Світлотехніка=>Точка. У діалоговому вікні Розрахункова точка 

необхідно спочатку задати приміщення. Для цього натисніть на кнопку 

Приміщення і за допомогою графічного курсору вкажіть на одне з ребер 

приміщення. 

Для завершення операції клацніть правою кнопкою миші чи натисніть 

на клавішу Enter. Уведіть координати розрахункової точки всередині 

приміщення у відповідні поля. Коли координати введені, натисніть на кнопку 

Розмістити, щоб розрахункова точка з’явилася усередині приміщення. 

Введення координат і розміщення повторіть для кожної розрахункової точки. 

Для виходу з діалогового вікна клацніть кнопкою ОК. У результаті всередині 

приміщення з’явиться зображення усіх уведених розрахункових точок 

(рис. 5.1). Якщо цього не відбулося, то або ви неправильно ввели координати 
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точок, або невірно обраний формат представлення точок на екрані. У 

першому випадку необхідно повторити введення точок, а в другому  

вибрати пункт меню Format=>Point Style і в діалоговому вікні стилю точок 

вибрати зображення точки у вигляді перекресленого кола і розмір точки  5% 

від розміру екрана. 

 

 

Рисунок 5.1 – Зображення побудованого приміщення з вікнами і розрахунковими 

точками 

Обчислення КПО розрахункових точок приміщення здіснюється за 

допомогою пункту меню СГМ=>Світлотехніка=>КПО. У діалоговому вікні 

КПО в точці всі необхідні коефіцієнти задані. Для зазначення приміщення 

натисніть на кнопку Приміщення і за допомогою графічного курсору 

вкажіть на одне з ребер приміщення. Для завершення операції клацніть 

правою кнопкою миші, чи натисніть на клавішу Enter. Аналогічно за 

допомогою кнопки Вікно здійснюється вибір вікна, через яке освітлюється 

приміщення. Для зазначення розрахункових точок натисніть на кнопку 

Розрахункові точки. Система перейде в режим вибору точок, а у вікні 

команд з’явиться запрошення Виберіть точки. Необхідно покажчиком миші 

по черзі вибрати всі розрахункові точки. Для завершення вибору натисніть 

праву кнопку миші. Після цього у вікні команд буде відображена інформація 
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про кожну розрахункову точку і КПО в цій точці. Щоб переглянути цю 

інформацію, потрібно залишити діалогове вікно, клацнувши кнопкою ОК, і 

розгорнути вікно команд на весь екран, натиснувши на клавішу F2. Тим же 

способом потрібно зробити розрахунок КПО в кожній розрахунковій точці 

через друге вікно і через два вікна одночасно, підсумовуючи КПО в даній 

точці відстані від кожного вікна. Отримані результати внесіть у табл. 5.3. 

Для обчислення КПО в  розрахункових точках при іншій орієнтації 

приміщення необхідно повернути приміщення за допомогою команди 

редагування Rotate і повторити усі вказані вище дії. Потрібно одержати 

значення КПО в розрахункових точках при східній, південно-східній, 

південній, південно-західній і західній орієнтації вікон приміщення. Для 

кожної орієнтації приміщення потрібно заповнити табл. 5.3. 

По завершенні лабораторної роботи збережіть отримане креслення для 

використання його в наступних роботах і залишіть систему СГМ. 

Вихідні дані для розрахунків 

Вихідні дані для приміщень і вікон наведені в Додатку 2. Координати 

розрахункових точок подані в Додатку 3. 

 

Таблиця 5.3  КПО розрахункових точок 

 

Номер 

точки 

Координати 

розрахункової 

точки 

КПО від 

першого вікна 

КПО від 

другого вікна 

КПО від 

двох вікон 

X Y Z    

1       

2       

…       

10       
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Контрольні запитання 

1. Назвіть умови  інсоляції розрахункової точки. 

2. Порядок завдання параметрів приміщення, вікон, розрахункових 

точок. 

3. Як обчислити КПО в розрахунковій точці? 

4. Як змінити орієнтацію приміщення? 

 

 

Практичне заняття 6 

ПОБУДОВА ПОВЕРХНІ РОЗПОДІЛУ ЗНАЧЕНЬ КОЕФІЦІЄНТУ 

ПРИРОДНЬОГО ОСВІТЛЕННЯ В ПРИМІЩЕННІ 

 

Мета роботи 

Використовуючи графоаналітичний метод, побудувати поверхні 

розподілу значень КПО в приміщенні і знайти мінімальне і максимальне 

значення КПО від одного та декількох вікон. 

 

Постановка задачі 

Відомі геометричні і світлотехнічні параметри приміщення і його 

вікон. Задано крок (дискретність) сітки розрахункових точок. 

Необхідно одержати графічну оцінку освітленості приміщення через 

кожне вікно і через усі вікна одночасно, побудувавши поверхні розподілу 

значень КПО. На цих поверхнях знайти мінімальне і максимальне значення 

КПО в приміщенні. 

 

Прядок виконання робіт 

Для графічної оцінки КПО приміщення на його умовній робочій 

поверхні (площині чи підлозі, паралельній їй на деякій висоті) вноситися 

сітка з заданим кроком. У вузлах цієї сітки обчислюється значення КПО. 

Отримані значення відкладаються по аплікаті (третій координаті) при 

обраному масштабі. Після обчислення КПО у всіх вузлах сітки одержимо 

безліч тривимірних точок, через які будується тривимірна поверхня 
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розподілу КПО приміщення через обране вікно. На поверхні відшукуються 

точки з максимальним і мінімальним значенням КПО. Таким способом 

здійснюється оцінка КПО приміщення через кожне вікно і через усі вікна 

одночасно. 

Запустіть систему СГМ. Якщо на диску існує файл креслення з 

попередньої роботи, відкрийте його за допомогою пункту меню File=>Ореn. 

Інакше почніть новий рисунок і визначить у ньому параметри приміщення і 

вікон так саме, як у лабораторній роботі 5. 

Побудуйте поверхню розподілу КПО приміщення через одне вікно, Для 

цього виберіть пункт меню СГМ=>Світлотехніка=>Поверхня КПО. У  

діалоговому, вікні, що відкрилось, Поверхня КПО необхідно задати всі 

необхідні параметри. У поле Крок сітки вкажіть крок сітки в мм для 

розрахунку КПО. Задовільні результати дає сітка з числом точок по кожній 

осі від 20 до 30. Виходячи з цього, задайте крок сітки. Наприклад, при 

ширині приміщення 7 метрів, щоб одержати 20 точок по осі X, потрібно 

задати крок по осі X рівним 350 мм. Для зазначення приміщення натисніть на 

кнопку Приміщення і за допомогою графічного курсору вкажіть на одне з 

ребер приміщення. Для завершення операції клацніть правою кнопкою  миші 

чи натисніть на клавішу Enter. Аналогічно за допомогою кнопки Вікно 

робиться вибір вікна, через яке освітлюється приміщення. Потім клацніть на 

кнопці Побудувати поверхню і для закриття вікна  на кнопці ОК. У 

результаті буде побудована поверхня розподілу КПО від обраного вікна (рис. 

6.1).  

Щоб на побудованій поверхні знайти точки з максимальною і 

мінімальною освітленістю, необхідно включити режим об’єктної прив’язки 

Intersection або Endpoint за допомогою пункту меню Tools=>Object Snap 

Selling. Щоб знайти на поверхні точки з максимальним і мінімальним 

значеннями по координаті Z використовуйте команду Tools=>Inquiry=>ID 

Point. Запишіть їхні координати. Значення координати Z відповідає 

значенню КПО в масштабі 200:1. 
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Рисунок 6.1  Побудована поверхня розподілу КПО від першого вікна 

Видаліть побудовану поверхню. Потім повторіть дії для побудови 

поверхні освітленості приміщення через друге вікно і через два вікна 

одночасно (рис. 6.2 і 6.3). Визначить для кожного варіанта точки з 

максимальною мінімальною освітленістю. 

 

 

Рисунок 6.2  Побудована поверхня розподілу КПО від другого вікна 
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Рисунок 6.3  Побудована поверхня розподілу КПО від обох вікон 

Для обчислення максимального і мінімального КПО при іншій 

орієнтації приміщення необхідно повернути приміщення за допомогою 

команди редагування Rotate і повторити усі вказані вище дії. Потрібно 

одержати значення КПО розрахункових точок при східній, південно-східній, 

південній, південно-західній і західній орієнтації вікон приміщення. Для 

кожної орієнтації приміщення потрібно заповнити табл. 6.1. 

 

Таблиця 6.1  Максимальний година інсоляції приміщення 

 

Орієнтація 

КПО від першого  

вікна 

КПО від іншого 

вікна 

КПО від  двох 

вікон 

X Y Z Imax X Y Z Imax X Y Z Imax 

С             

Пд-С             

Пд             

Пд-3             

З             

 

По завершенні лабораторної роботи збережіть отримане креслення для 

використання його в наступних роботах і залишіть систему СГМ. 
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Параметри для приміщень і вікон вибираються в додатку 2.  

 

Контрольні запитання 

1. Опишіть геометричний метод розрахунку природного освітлення. 

2. Як з використанням системи СГМ побудувати поверхню розподілу 

КПО приміщення? 

3. Викладіть технологію визначення точки усередині приміщення з 

максимальним значенням КПО. 

4. При якій орієнтації приміщення отримана точка з максимальним 

значенням КПО? 

 

 

Практичне заняття 7 

ВИЗНАЧЕННЯ ЗОН КОМФОРТУ (ДИСКОМФОРТУ) ПО 

КОЕФІЦІЄНТУ ПРИРОДНЬОГО ОСВІТЛЕННЯ ТА ОБЧИСЛЕННЯ ЇХ 

ХАРАКТЕРИСТИК 

 

Мета роботи 

Використовуючи графоаналітичний метод і побудовану з його 

допомогою поверхню розподілу значень КПО від усіх вікон одночасно, 

визначити зону комфорту по КПО і знайти її характеристики. 

 

Постановка задачі 

Є поверхня розподілу значень КПО в приміщенні через усі його вікна. 

Відомі максимальне і мінімальне значення КПОmin і КПОmax. Задано 

припустиме значення КПОд, що задовольняє умові КПОmin< КПОд < КПОmax.  

Необхідно побудувати зону комфорту по КПО, обчислити її площу, а також 

коефіцієнт комфортності по КПО приміщення, що знаходиться як 

відношення площі комфорту до загальної площі приміщення. 

 

Прядок виконання робіт 

Для знаходження демаркаційної кривої (границями між зонами 
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комфорту і дискомфорту) на висоті, що відповідає припустимому значенню 

КПОд, будується площина, паралельна робочій поверхні. Знаходиться 

перетинання даної площини з побудованою поверхнею розподілу 

освітленості в  приміщенні. Отримана крива проектується на робочу 

поверхню (площину або підлогу, паралельну їй, на висоті 0,8 м). У результаті 

одержимо границю зон комфорту і дискомфорту по КПО. Ці зони можуть 

бути в загальному випадку незв’язними, тобто являти собою кілька 

непересічних областей. 

Для отриманої зони комфорту по КПО обчислюється її площа, а потім 

коефіцієнт комфорту по КПО. 

Запустіть систему СГМ. Якщо на диску існує файл креслення з 

попередньої роботи, відкрийте його за допомогою пункту меню File=>Open. 

Інакше почніть новий рисунок, визначте в ньому параметри приміщення і 

вікон так само, як у лабораторній роботі 5, побудуйте область розподілу 

освітленості в  приміщенні через два вікна, як і в у лабораторній роботі 6. 

Зона комфорту за освітленістю будується за допомогою діалогового 

вікна, викликаного по команді СГМ=>Світлотехніка=>Зона комфорту. У 

діалоговому вікні, що відкрилося, за допомогою кнопки Приміщення 

необхідно вказати приміщення, а в поле Припустимий КПО  ввести 

припустиме значення КПО. Побудова зони комфорту починається після 

натискання на кнопку Побудувати зону комфорту. Щоб побачити результат 

побудови, потрібно закрити діалогове вікно, клацнути на кнопку ОК. 

Щоб одержати кількісні характеристики отриманої зони комфорту, 

потрібно за допомогою команди PLINE обвести границю зони (рис. 7.1) , і 

командою Tools=>Inquiry=>Area  опцією Entity зробити розрахунок площі 

зони комфорту. Для того щоб одержати значення зони в м2, необхідно 

розділити отримане число на 106. Запишіть отриманий результат. Обчислите 

коефіцієнт комфорту по даному КПОд. Для цього необхідно розділити 

отриману площу комфорту на загальну площу приміщення. 
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Рисунок 7.1 – Побудована зона комфорту для двох вікон 

Розрахунок площі зони комфорту і коефіцієнта комфорту необхідно 

зробити для різних кутів орієнтації приміщення. Отримані результати 

занесіть у табл. 3.1. 

Параметри приміщень і вікон вибираються з Додатку 2. Побудувати 

зони комфорту і знайти коефіцієнт комфорту по КПО для наступних значень 

КПОд=2%, 3%, 4%, 5%. 

 

Таблиця 7.1  Показники комфорту по інсоляції 

 

Орієнтація Площа зони комфорту Коефіцієнт комфорту 

С   
Пд-С   
Пд   

Пд-З   
З   

 

Контрольні питання 

1. Опишіть технологію побудови зони комфорту по освітленості 

приміщення. 

2. Як засобами системи СГМ побудувати зону комфорту з 

припустимим значенням КПО 1.52? 

3. При якій орієнтації приміщення коефіцієнт комфорту за освітленістю 

максимальний? 
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ДОДАТОК 2. Вихідні дані для розрахунку 

 

Вихідні дані для приміщень і вікон 

№ за 

списком 

Приміщення Параметри 1-го вікна Параметри 2-го вікна 

Шир. Глиб. Вис. Шир. Вис. Підв. Зсув Шир. Вис. Підв. Зсув 

1 4800 3600 3000 1200 1200 900 900 1500 1200 1000 3000 

2 5100 4200 3000 1200 1200 900 900 1500 1200 1000 3000 

3 5400 4800 3000 1200 1200 900 900 1800 1200 1000 3000 

4 5700 5400 3000 1200 1200 900 900 1800 1200 1000 3000 

5 6000 6000 3000 1800 1200 900 900 2100 1200 1000 3000 

6 6300 6600 3300 1800 1200 900 900 2100 1200 1000 3900 

7 6600 7200 3300 1800 1200 1000 1100 2400 1200 1000 3900 

8 6900 7800 3300 1800 1200 1000 1100 2400 1200 1000 3900 

9 7200 8400 3300 2400 1400 1000 1100 2700 1200 1200 3900 

10 7500 9000 3300 2400 1400 1000 1100 2700 1200 1200 3900 

11 7800 9600 3600 2400 1400 1000 1100 3000 1500 1200 4800 

12 8100 10200 3600 2400 1400 1000 1100 3000 1500 1200 4800 

13 8400 10500 3600 3000 1400 1100 1300 3300 1500 1200 4800 

14 8700 10800 3600 3000 1400 1100 1300 3300 1500 1200 4800 

15 9000 11100 3600 3000 1400 1100 1300 3600 1500 1200 4800 

16 9300 11400 3900 3000 1400 1100 1300 3600 1500 1200 5400 

17 9600 11700 3900 3600 1600 1100 1300 3900 1500 1500 5400 

18 9900 12000 3900 3600 1600 1100 1300 3900 1500 1500 5400 

19 10200 12300 3900 3600 1600 1200 1500 4200 1500 1500 5400 

20 10500 12600 3900 3600 1600 1200 1500 4200 1500 1500 5400 

21 10800 12900 4200 4200 1600 1200 1500 4500 1800 1500 6000 

22 11100 13200 4200 4200 1600 1200 1500 4500 1800 1500 6000 

23 11400 13500 4200 4200 1600 1200 1500 4800 1800 1500 6000 

24 11700 13800 4200 4200 1600 1200 1500 4800 1800 1500 6000 

25 1200 14100 4200 4200 1800 1300 1700 5100 1800 1500 6600 

26 12300 14400 4500 4800 1800 1300 1700 5100 1800 1500 6600 

27 12600 14700 4500 4800 1800 1300 1700 5400 1800 1500 6900 

28 12900 15000 4500 4800 1800 1300 1700 5400 1800 1500 6900 

29 13200 15300 4500 4800 1800 1300 1700 5700 1800 1500 6900 

30 13500 15600 4500 4800 1800 1300 1700 5700 1800 1500 6900 
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ДОДАТОК 3. Координати розрахункових точок 

 

№ за 

списком 

Координати  розрахункових  точок 

Коорд. 1-ої точки Коорд. 2-ої точки Коорд.3-ої точки Коорд. 4-ої точки 

X Y Z X Y Z X Y Z X Y Z 

1 100 100 800 1600 1200 0 2400 1800 800 4700 3500 0 

2 100 100 800 1700 1400 0 2500 2100 800 5000 4100 0 

3 100 100 800 1800 1600 0 2700 2400 800 5300 4700 0 

4 100 100 800 1900 1800 0 2800 2700 800 5600 5300 0 

5 100 100 800 2000 2000 0 3000 3000 800 5900 5900 0 

6 100 100 800 2100 2200 0 3100 3300 800 6200 6500 0 

7 100 100 800 2200 2400 0 3300 3600 800 6500 7100 0 

8 100 100 800 2300 2600 0 3400 3900 800 6800 7700 0 

9 100 100 800 2400 2800 0 3600 4200 800 7100 8300 0 

10 100 100 800 2500 3000 0 3700 4500 800 7400 8900 0 

11 100 100 800 2600 3200 0 3900 4800 800 7900 9500 0 

12 100 100 800 2700 3400 0 4000 5100 800 8000 10100 0 

13 100 100 800 2800 3500 0 4200 5200 800 8300 10400 0 

14 100 100 800 2900 3600 0 4300 5400 800 8600 10700 0 

15 100 100 800 3000 3700 0 4500 5500 800 8900 11000 0 

16 100 100 800 3100 3800 0 4600 5700 800 9200 11300 0 

17 100 100 800 3200 3900 0 4800 5800 800 9500 11600 0 

18 100 100 800 3300 4000 0 4900 6000 800 9800 11900 0 

19 100 100 800 3400 4100 0 5100 6100 800 10100 12200 0 

20 100 100 800 3500 4200 0 5200 6300 800 10400 12500 0 

21 100 100 800 3600 4300 0 5400 6400 800 10700 12800 0 

22 100 100 800 3700 4400 0 5500 6600 800 11000 13100 0 

23 100 100 800 3800 4500 0 5700 6700 800 11300 13400 0 

24 100 100 800 3900 4600 0 5800 6900 800 11600 13700 0 

25 100 100 800 4000 4700 0 6000 7000 800 11900 14000 0 

26 100 100 800 4100 4800 0 6200 7200 800 12200 14300 0 

27 100 100 800 4200 4900 0 6300 7300 800 12500 14600 0 

28 100 100 800 4300 5000 0 6400 7500 800 12800 14900 0 

29 100 100 800 4400 5100 0 660 7600 800 13100 15200 0 

30 100 100 800 4500 5200 0 6700 7800 800 13400 1500 0 
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